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Purpose:  To provide an overview of each SMARTSystem Main Menu, Sub-

menus, Staff permissions and Security. 

 

Keywords:  The following is a list of key terms used in the SMART System that 

you should be familiar with and understand. 

 

For example, to standardize information in the SMARTSystem we utilize pre-

requisites.  A Pre-requisite is required prior to the entering of some other data.  

For example, a salesperson (staff entry) is needed prior to entering customers. 

 

Here are some other keywords to review and become familiar with: 

 

 Menu – A list primary options. 

 Sub-menu – A list of options available under a Main Menu. 

 Table – Refers to data (pieces of information) arranged in rows and 

columns, as in a spreadsheet.  In the SMARTSystem all information is 

stored in the form of tables. 

 Spreadsheet – Is a table of values arranged in rows and columns, like an 

Excel spreadsheet. 

 Columns – a column is a vertical line of characters from the top to the 

bottom of the screen 

 Rows – a row is a horizontal line containing a series of fields placed next to 

each other. 

 Database – An organized collection of data. 

 Data – The quantities, characters, numbers and symbols that are entered, 

stored and used in the computer. 

 POS – Point of Sale 

 SQL (Structured Query Language) – is a program responsible for 

managing the SMARTSystem information in the database. 

 View – a term used in the SMARTSystem to be able to see and select 

information. 

 System Control – a specific table that stores information used to configure 

and save your Company information in the SMARTSystem. 
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Training Procedure for this Training Session: 

 

 Introduction to Terminology 

 Go through the menus across the top of the screen 

 Select each Main Menu 

 Go over the sub-menus below each Main Menu 

 Proceed to the next menu 

 Do Staff Entry, Permissions and set Security 

 

 

Introduction to Windows Terminology: 

 

The Microsoft Windows terminology for the window itself is illustrated below: 

 

 
 

 
 

SMARTSystem Title Bar & Menu Bar: 
 

 
 

The blue bar across the top of the screen is called the TITLE Bar.  It provides 

information at the top of the window identifying the SMARTSystem program 

name, Version number as shown above “Version 6.7.4.7” and the name of the 

Workstation you are on. When your local network environment is all 64 Bit 

computers the “64 Bit Mode Enabled” is shown. This information is used to 

Support and tells us which version of the program is running and what PC it is 

running on. 
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The MENU Bar above shows the main Menu items that you can access for 

functions within the SMARTSystem program and these main Menu items can be 

restricted based on a user login established for each STAFF member.  

 

Main Menu items include: 

 File 

 Sales 

 Purchase Orders 

 Vendors 

 Customers 

 Staff 

 Inventory  

 Shipping 

 Reports 

 Management 

 End-of-Day 

 POS 

 Drivers 

 Control Info 

 Help 

 

Selecting each main Menu item will display their related sub-menus.  The 

following is an example of Sub-menus under the Main menu item SALES: 
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Staff Menu: 
 

Selecting the Staff Menu provides for the entry and maintenance of your Company 

staff information and access to related menu items: 

 

  
 

 

Selecting “Staff Entry” provides for the creation and maintenance of user 

information for the SMARTSystem.  The Staff Table Maintenance screen will be 

displayed showing 4 tabs: Name & Address, Personal Information, Advanced 

Security and Database Selection. 
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Name and Address Tab: 

 

The Name and Address Tab contains important information and will give certain 

permissions to your staff. 

 

To begin, the Staff Code can be any 5-character code or employee number.  

Frequently, the first few characters of the person’s first name are used. 

 

If you do not want to enter the persons address information, just enter a period “.” 

in the Address Line 1 and City fields.  Address Line 2 is optional. 

 

The Division Assigned has been pre-defined for you and it can modify by you. 

Additions or changes are made to this list by selecting the Division sub-menu 

under the Staff Menu.  This information is required to show what area the person is 

working. It will not have impact on any SMARTSystem operations. 

 

  
 

 

Each Staff member has an Authorization Level: 

 
 

There are 4 Global Authorization Levels that function as follows: 

 0=No Access is used when someone is terminated, but their information may 

be referred to when accessing history information. 

 1=Sales Person limits a sales person to only their customers and with other 

restrictions.  This Authorization Level restricts access to customer accounts 

assigned to other sales staff. 

 2=User is the normal option which automatically restricts access to the 

following menus: 

o STAFF and 

o CONTROL INFO and 
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o Any restrictions are established using the Advanced Security Tab.  

 

 3=Manager provides total access to all menus and restrictions are 

established using the Advanced Security Tab.  

 

For each Staff member, you need to set a User Name and Password for them to log 

into the SMARTSystem.  Neither entry is case sensitive, 

 

 
 

Additional staff permission options are: 
 

  
 

 User is a Cashier (POS Configuration Will be Applied) 

 

For a User to have the POS Main Menu, a SMARTSystem configuration on 

the PC used for Point of Sale (POS PC) is required. Refer to Training 

Session #5B for additional information and setup. 

 

In addition, the Staff Login needs to have this checkbox set to utilize all of 

the POS features when this person signs onto the POS PC. 
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 User is an Inventory Administrator 

 

When the SMARTSystem is set for Weighted Average Cost (WAC), then 

this option applies. 

 

 Control Info > System Control > Options 

 

  
 

The SMARTSystem will prevent any User from changing inventory costs: 

 

 Current Landed Cost or  

 Average Landed Costs  

 

without a password. 

 

  
 

When a User has this check box set they are authorized and do not have to 

enter a password. 

 

  
 

 

Here is what the screen will look like when prompted for a password: 
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 Show totals on Sales, Invoice and PO Views 

 

The Total Sales, in the lower right corner of these screens is available for all 

Users or only selected Users.  For example on the Sales view: 
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In System Control, you can “Hide Totals on Sales Views” for all Users by 

checking this box.  Access to this box using menus: 

 

Control Info > System Control > Options 

 

 
 

Therefore, some Users with authorization can override this “Hide” option and 

view the Totals. 

 

 

 User is a Driver 

 

The “Driver Check-in” feature is used by delivery drivers to check in their work 

on a daily basis after completing a route. Display this Main menu by 

unchecking this option: 

 

  Control Info > System Control > Sales Options > Hide/Show Options 

 

    
  

 

 User is a Surcharge Administrator 

 

A password is required to change a Customer Surcharge.  A User can be 

assigned responsibility to change customer surcharges and by checking this 

box in their staff record they will not be required to enter a password: 

  
 

This checkbox, on the second tab “Sales Info” in the Customer table sets 

Surcharges by customer.  
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 Include in Dashboard 

 

The Manager’s Dashboard is a software module to keep owners and 

managers updated on today’s sales activity. A separate icon will appear on 

your desktop to select the Manager’s Dashboard program:   

         
 Checking this box will include the User in the Dashboard statistics: 

   
 

 Sample Dashboard showing Weekly Report:

 
 

 

 

 

 

 User Cannot Cancel Sales Orders 

 

When this option has been set, Sales Orders not Invoiced can be 

CANCELLED: 
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  the red CANCEL button does not show on the Sales Order screen: 

  
 

 

 User Can Cancel Invoiced Sales Orders 

 

 
When this checkbox is NOT set, the following message will appear when a 

User attempts to cancel an invoiced sales order:   

 

   
  

 

If this checkbox is set the invoiced sales order can be CANCELLED using 

the Supervisor Password: 
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 User can Delete Credit Memos 

 

 
A User with this checkbox can access credit memos and a button will appear 

to “Delete Credit Memo” from the System. There is no audit trail with this 

action. 

   
 

 

 Only allow printing options in Recipe Portal 

 

This applies to our bouquet recipe portal only.  The user logged in will not 

have the print button visible to print documents: 

 

   
 

 

Personal Information Tab: 

 

There are only 3 required fields on this screen: 

 

 Nick Name – allows an alias to be printed on the customer invoice 

 Initials – used on screens and reports 

 E-mail Address –  two specific uses: 

 A SMARTSystem option can be set to use the User’s email as the 

FROM address when emailing an invoice, price list, etc.  This feature 

is set as follows: 

 

Control Info > Options > General Options 

 

 
 

 This is used with your integrated e-Commerce website to notify the 

sales rep that an order was placed on the website by their customer. 
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Advanced Security Tab: 

 

User access to the Menus and Sub-menus is defined under the Advanced Security. 

 

The yellow highlighted line represents the main MENU items on the menu bar. 

When unchecked all the items under it are not available. 
 

All menus and sub-menus can be checked by clicking Check All.  Uncheck All 

will remove all menus and sub-menus.  You must check which ones this user has 

access to when logged on. 
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Database Selection Tab: 
 

When multiple branches exist, there may be multiple databases available.  If there 

is more than one database available, this selection would be the default database 

this User is assigned to: 
 

 
 

Now, continuing to review the main Menus from left to right we have: 

 

Master Menu Overview: 

 

File 
 

This Menu should be restricted to senior staff.  It provides sub-menus to import 

data, backup the database, restore the database, log off and exit. 

 

You do not want anyone to restore the Database unless they know where the last 

backup is stored and why they are doing it. See the File Menu selection below: 
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Sales 

 

The screen below represents the Sales Menu items that are available. 

 

The Sales Menu will provide access to all sales related functions. Prior to entering 

a sales order there are pre-requisites required, such as, entering your sales staff, 

assigning staff to your customers, establishing terms, etc. 

 

The sub-menu items at the bottom of the Sales Menu that have “(Inquiry)” are for 

your sales staff with limited access to your information.  This “Inquiry” only 

program will allow a User to view information, but not change it. 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want.  See the Sales Menu selection below: 
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Purchase Orders 
 

The screen below represents the Purchase Order Menu items that are available. 

 

The Purchase Order Menu will provide access to all buying related functions. Prior 

to entering a purchase order there are pre-requisites required, such as, establishing 

vendors, vendor farm codes for selective selling, buyers, ship via, etc. 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Purchase Order Menu selection below: 
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Vendors 
 

There are certain pre-requisites that are required for vendor information to function 

smoothly.  These pre-requisites include: vendor type, terms, ship via, state and 

country tables.  

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Vendor Menu selection below: 
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Customers 
 

There are certain pre-requisites that are required for customer information to 

function smoothly.  These pre-requisites include: salesperson, customer type, terms 

and ship via.  

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Customer Menu selection below: 

 

 
 

Staff 
 

The Staff Menu was already reviewed above. 

 

 
 

 

Inventory 

 

There are certain pre-requisites that are required for inventory information to 

function smoothly.  These pre-requisites include: product type, product category, 

product item, product size, product color, unit of measure, etc.  
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The items on this menu below “Hold List Processing” apply to a SMARTSystem 

configuration for bucket truck operations. 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Inventory Menu selection below: 
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Shipping 
 

The Shipping function provides solutions for warehouse operations to maintain 

better control.  

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Shipping Menu selection below: 
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Reports 
 

There are seven areas of reporting which consist of additional sub-menus: 

 

 Sales Reports 

 Purchasing Reports 

 Inventory Reports 

 Grower Reports 

 Management Reports 

 Labels 

 SMART Mobile Suite 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Reports Menu selection below: 

 
 

 



SMARTSystem Management Training Series 
Training Session #2 – SMARTSystem Menus, Staff Entry and Security 

 

 

Document: MTS2  Page 22 
Revised: February 11, 2017 
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SMARTSystem Management Training Series 
Training Session #2 – SMARTSystem Menus, Staff Entry and Security 

 

 

Document: MTS2  Page 24 
Revised: February 11, 2017 
 

Management 
 

This function provides menu items that are normally managed by supervisory staff. 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Management Menu selection below: 
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End-of-Day 
 

 

The End-of-Day process will export information from your SMARTSystem to 

your accounting system which includes: 

 

 New Customers or changes to customer information 

 New Vendors or changes to vendor information 

 New Inventory Items or changes to Inventory information 

 Inventory Adjustments 

 Received Purchase Orders 

 Invoiced Sales Orders 

 Sales Credit Memos 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the End-of-Day Menu selection below: 
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Driver 

 

Driver is for orders that are done via truck and can be used for mobile delivery. 

 
 

POS 
 

Point-of-Sale (POS) processing is optional and POS workstations require 

SMARTSystem configuration to operate in POS mode.   

 

This POS program will provide for: 

 A cash drawer 

 Thermal receipt printer 

 Bar Code Scanning of product 

 Signature Pad that will capture and store the signature electronically 

 Credit Card processing for payments 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the POS Menu selection below: 
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Control Info 
 

Control information should be restricted to only senior management staff.  In 

addition, training for the System Control sub-menu option is required. 

 

In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the Control Info Menu selection below: 

 

 

 

 
 

 

HELP 
 

The Help Menu will provide documentation and operational tools to help you 

manage your PC better. 
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In your Staff Advanced Security, you make available to each User access to the 

programs you want. See the HELP Menu selection below: 

 

 
 

 

The HELP Documentation can be accessed directly in the SMARTSystem by 

selecting the HELP menu or pressing the F1 key on any program screen. 

 

Questions and Answers 
 

If you have any questions or need support, please contact us at 

Support@Floralcomputer.com or call 727-483-5306 for assistance.  

 

Practice Drills 
 

The purpose of a Practice Drill is to get you more familiar with the SMARTSystem 

and comfortable using it. 

 

1. Login into SMARTSystem  

2. Go to the STAFF Menu and select Staff Entry 

a. Select your Staff information and change your password 

b. Click “Modify” and Exit the program 

c. Exit the SMARTSystem using the red “X” 

 

 

 

 

 

 

 

mailto:Support@Floralcomputer.com
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How to Add Staff 

1. In the file menu bar select the word “Staff” from the list.  

 

2. In the drop down list under Staff choose “Staff Entry.”  

 
 

3. A pop up window entitled “Staff Table Maintenance” will open to the tab 

called “Name & Address.”   

 
 

4. Type the information for your new Staff entry.  
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Staff Code must be entered before you can save your entry and move on to 

another staff entry. The Staff Code is any 1 through 5 letters, numbers or a 

combination of letters and numbers that you make up that help you to refer 

to your new Staff entry.  

5. Required fields are Address, City, State, Division Assigned, Authorization 

Level.  

6. Create a unique User Name and Password for the new staff entry.   

7. In the lower right hand section of the Name & Address box is a list of 

optional items that may be checked to further designate your staff user.  

 
Check any of the boxes if needed.  

 

8. Click the Add button. The “Personal Information” tab opens and the “Nick 

Name” field needs to be entered. It is highly recommended to add the email 

address of the staff entry. 
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*Please note that the Advanced Security Tab will already be populated with 

checked items for the default Authorization Level that you have chosen for 

the staff individual. Changes can be made to the authorizations of an 

individual staff member at any time by the staff administrator.  
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9. Click the Add button and your new staff entry is added. 

 
Practice Drill Part 2 Check your work. 

3. Login into the SMARTSystem with your User Name and new password 

4. For the person responsible for entering and maintaining Staff, enter a new 

STAFF record or make one up.  If you make up a name inactivate it. 

 

  

 

 

 

 


